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WELCOME TO THE

Destination for

Everything Home

We offer the largest selection, across all
styles and budgets, at your fingertips — as
well as a dynamic brand experience that
goes far beyond shopping.




Waytair isn't just a retailer

We're a resource for our visitors. We inspire and excite with fresh ideas and a beautiful site experience.

HELPFUL DOWN-TO-EARTH FUN EMPOWERING INNOVATIVE
We offer smart solutions We are approachable, We take what we do We make customers feel We keep our audience
to everyday problems in a easy-going, and seriously, but try not to comfortable improving informed on fresh and

conversational tone. unfussed. take life too seriously. their life at home. iInnovative décor trends.




WAYFAIR AT A GLANCE:
Demographics

Our shoppers are savvy DIY-ers ready to

tackle their next big project.

They know their style, but are always open
and seeking new ideas and inspiration.

They love the journey.

* & ® 8
60% FEMALE AUDIENCE * * @ * *
Ages
35-65 * "

Median Household Income

$85K

Household Size

Between 2-5

Years in Current Home

3+



Our Media Partners:

KOHLER SHERWIN

. WILLIAMS
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Waytair as a Publisher

!"‘

ENGAGEMENT
We create compelling,

Pemmmen - JEHIETIRERG

CURATION i‘

We focus on delivering a brand ‘;
FLEXIBILITY

Our exclusive content,

interactive branded content “ experience that's robust, easy to

that delights and engages navigate, and backed by top

our audiences at scale INSPIRATION influencers in the

Our visitors are leaning home design industry

o technology, and creative
forward, seeking ideas and

_ teams work together to
advice — and they trust us as ‘
| develop new product ]
an authority on trends,
features and a custom
products, and more ,

brand experience

......




A Zillion Media Opportunities

CUSTOM CONTENT EXPERIENCE
' Through articles and custom brand experiences

HIGH-IMPACT DISPLAY ADS
Drive traffic on- and off-site across devices with
IAB & nonstandard native options

SOPHISTICATED TARGETING
Catered to life stages leveraging 15t —party
shopping data

SEASONAL SPONSORSHIPS
Create opportunities for increased exposure
during relevant, high-profile events

TV & SOCIAL AMPLIFICATION
Partner with influencers to reach customers

across platforms with relevant, engaging content

ADDITIONAL SERVICES & SISTER BRANDS
Offer highly trafficked campaigns on AllIModern,
Joss & Main, Business and Trade Services

wayfa?r

Find anything for your

. LK ia ~.0.
Ny Booecks Ides Accounrt s

Fumnitwre Decor Lighting Kitchen Bed & Bath Storoge Outdoor Home Improvement Baby & Kds Seazonal Giftz  Sales

UP TO 70% OFF PRESIDENTS' DAY BLOWOUT,

Free Shipping Over $49*

Lighting Kitchen Bed & Bath Storage Outdoor Home Improvement

Wayfa}r Find anything for your home...

Furniture Décor

MyBoards Ideas Account  C

O ¥ ® @9
les

Baby & Kids Seasonal Gifts Sal

Shop By Room

Bedroom
Living Room
Dining Room
Kitchen
Bathroom

Entry & Mudroom

Top Categories
Renew & Re-Org Sale
White Sale

Rugs

Wall Art

Bar Stools

Ways To Save
Daily Sales

Clearance Outlet

— UPTO —

. 70%

Furniture for Every Room

Kick-start your new year with fresh furniture deals »

Shop the Show

e up to 70% on looks from the latest episode »

!ESIGN cxxmuﬁ
MONDAY 9/8c HCT\

9.99: Renew & Re-Org Sale » I Up to 70% OFF

Winter White Sale »

SONY

Entertain with Style

— Daily Sales —

\~

Bedroom Furniture »

Bed & Bath Linens »

Shop All Sales »

Cusform

Comfort

Living Room » - Beavoom Furnitwe «

it Bedang »

ent My, whare Waylor and Sony hawe portnered 10 bring you t™he most
Yat afow your 10 bolonce sty'e and funchon e never before. See how these

enterionmert drugm con At intn your fomdy oo

fty. ortusre Gat roady for a powerfis, smmanive sound bar aapenence Tal makes your

favorie music, moviers, Bod sirmameng arfertarerar t come 0 Me




Custom Content
Experience

WHAT WE OFFER:

A dedicated base of home enthusiasts seeking
Inspiration and advice. Unique landing pages
tailored to your desired experience

A dynamic breadth of optional assets, including:

* Sponsored articles

* Influencer content

* Embedded videos

« Social media integration
* Photo galleries

* Promotional campaigns

« Mobile optimization

Free Shipping Over $49* Help

. O ¥ ® @
; i i Search ¢
wanalr PRl ey teng e youshome My Boards Ideas Account Cart

Furniture Décor Lighting Kitchen Bed & Bath Storage Outdoor Home Improvement Baby & Kids Seasonal Gifts Sales

FROM $9.99: Renew & Re-Org Sale » [zé Up to 70% OFF: Winter White Sale »

= =

RESTORE & RENEW

We're here to help you DIY your way to a better space with tips, tricks, —
and exclusive content— all featuring products from the brands below.

>

3 =
R A R TR AN i e
) { MINWAX. Pllrdy Thompsons
Make It Yours~ nwxoomwmuam" ooy e oo 3% ‘VV\afe’ a /s

— ———

DIY Ornament Makeover

Try this quick DIY to give your
Christmas ornaments a sparkling
new look with Krylon!

Read More »

Home Projects to Prep
for Holiday Guests

Quick home improvement projects
with Purdy brushes to get your
house ready for holiday visitors!

DIY 1 Bar Stool 3 Ways with Krylon®
Watch Now »

Read More »

How to Enjoy Your Deck
All Year
With the help of Thomspon's

WaterSeal you can enjoy your
deck no matter the weather,

Spruce Up Your Home for
the Holidays
With furniture-saving products

from Minwax, your home will
sparkle just in time for guests.

Read More » Read More »

DIY Videos

your purchase of
$60 or more at
SHERWIN-WILLIAMS.

Get the Wayfair = ..o | [iomamm—m—,

S App Store Just Ask Bruce: Choosing the Purdy Presents: How to Paint Around Thompson's WaterSeal: Penetrating

r» Perfect Stain Color » Fixtures » Timber Oil »

iPhone App »

About Our Brands

A [
Afm ‘.’ !M

Sign up for Daily Sales. Don't miss out!

NGRS Cnter your emall address

Careers | Desktop Site | Contact Us: 866-263-8325

Privacy | Terms of Use | © 2016, Wayfair



Free Shipping Over $49* Help

* O ¥ ©® @
2 Fi hi h <
Wanalr ind-anything for.your:home m My Boards Ideas Account Cart

Furniture Décor Lighting Kitchen Bed & Bath Storage Outdoor Home Improvement Baby & Kids Seasonal Gifts Sales

FROM $9.99: Renew & Re-Org Sale » )@ Up to 70% OFF: Winter White Sale »

Promoting Your Content

We offer high impact, integrated ad placements across platforms

Shop By Room
Bedroom

DESIGN SPEAKS [RaiAis

Dining Room
Follow our bold bathroom

and devices — there are endless ways to discover content. e | e | D IR DsicN SPEAKS

THEBOLD LOOK
O KOHLER.

Learn More »

Follow our bold bathroom
transformations, brought
to you by Kohler

Learn More »

Placements can be standard IAB, or native nonstandard sizes § g

Renew & Re-Org Sale
White Sale

Rugs
Wall Art

depending on your brand’s goals.

Bar Stools
Ways To Save ! L ‘7 1A = —]
Daily Sales - - g 3
& Clearance Outlet i { \ =
RAILS ' * RAILS
' 760% Furniture for Every Room — Daily Sales —
OFF Kick-start your new year with fresh furniture deals »

Living Room Rugs »

Furniture »

Wall Décor » Lighting »

g W‘ .
Shop the Show ~

Bedroom Furniture » Bed & Bath Linens »

;
.

Save up to 70% on looks from the latest episode »
@

MONDAY o/8c GV

Shop All Sales »

.

HOMEPAGE
300x250

(pOTUGHT o

KOHLER

Jana Bek: Bathroom Makeover DKOR |Interiors: Powder Rcom Part 5 DKOR Interiors: Powder Room Part 6

See all Projects » See the Project » See the Project » B RA N D
- — T
R - -
b 5 |
» \_{‘ | - b -
N\ i g
r&j : - HUB
| i | 2
. > \ 2
ol \
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High-Impact Display Ads

Available both direct and programmatically. Let us drive positive brand lift, like we did for one brand who saw a lift of
+8.3% when advertising on our site.

Free Shipping Over $49°* et Free Shipping Over $49* Mew Free Shipping Over $49* Help REL Shopng AN Orders Over 349 Metp 800 Y60 608,
3 Q : © - (V] e ® @ Y () X% @ Q o
Find anything for your home. Search v v \ Find anything for your home.. Search v : \ Hd i Tl o e G - il A . 44 ) @,
wayfair e . L wayfair Mo e A 1054 wayfair yiing fory Wi ik D wayfalr o . oy o ccont B
Furniture  Décor Uighting Kitchen Bed & Both Storage Outdoor Home Improvement Boby & Kids Seasonal  Gifts Sales Furniture Décor Lighting Kitchen Bed & Bath Storage Outdoor Home Improvement Baby & Kids Seasonal Gifts Sales s Light Kheh esaaean s o % i Boby & Kids v it Sok
‘urniture  Décor ting Kitchen th Storage door  Home Improvement ids Seasonal les
A\ FROM $9.95: Renew & Re-Org Sale » I ust Winter White Sale » A FROM $9.95: Renew & Re-Org Sale » LZa U 1o 70% OFF: Wintar White Sale » Forihe: Dicor: Lighting Kiichen | Bed &Soth Swioge) | Quidoor Home lmprovement| Soby &iids More... Gifis  Scles

7. FROM $9.99: Renew & Re-Org Sale » Liga U to 70% OFF: Winter White Sate » -
Décor > Rugs > Area Rugs Ughting > Ceifing Lights > Pendonts > Birch Lone > SKU: BLIE38 @fFVvsm

2~ o ¢ Foe
Area Rugs r nization [ ’ J H
9 Sutton Pendant by Birch Lane Storoge & Opganitzatiol ‘ ~ W @® -~ (] -
c— e e o ——— B o - o .2 @ - ‘
$189.00 = o Room > ) - - - -

Free Shipping Closes
Ships by Thu (1/14)

Entry & Mudroom UP TO 70% OFF

renew

Refine I (;,f \{‘_, 3 [:r L

Kitchen r
—— omoon €-org sale Editors' Picks for Cupcake Lovers
" Select Finish: Cleor Bedroom
S » Get Orgonized for Less Check out these cute cupcoke supphies, from cupcoke stands to
| = i 1 Office
209 t w o
wxi NS ' - <
3 Select Size $ >
Funnes Pnomasyy o o - Neat & Tidy Entryway f Py B
oo Henderson Creom & Beige Area Artemis Blue Areo Rug Area Rug
Quantity: 1 s Storoge Essentials
Ny b Mercury o O Andove WAt g Stylish Closet Solutions
by Ao Stovope Sohitions:
$36.99 - $333.99 59507 $42.99 - $515.99 55336 $38.99 - $457.15 14544 - © Save to Idea Board Housekeeping & Loundry
2-Day Delivery B j Y I > Shelving — £
o 2 = O
- - Kids Storoge N
E MHolday Storoge S o
Customers Also Viewed
x Ideas & Advice
price i
i \ Double Duty Decorative Boxes
Top 10 Storage Benches
S b ot
5 > Our Favorite Organizat Finds
Sl a0 Tolisker Mini Pendant Bosworth Mini Pend.. Grayson Pendant Pillips Mini Pendant Loundry Room Storage Essentiols %
$20010 5300 ‘s7900 Sis300 12000 6800 o,
How 1o Organize 6 Smoll Bathroom
P00 More Opoons « Mare 0 Out Foverita Poar
- Pramria Adi B Natural T ons  Shipping & Returns  Reviews  Q&A Recipss
by Bcyden Sidio b Anover Ml e,
$5008 Avove eeec0 Verizon 7 10:16 AM @ 65% W
s © f' \{\ $23.99 - $248.53 §123.00 $38.99 - $149.99 6560 .
2.Day Delivary wayfair.com

[product above to your cart, we make it easy to select more tems you
1972)

Tiffany Upholstered Platform
Bed
by DHI

from $244.99 $327:60

Free Shipping 0505 0 bowed shape and bronzed metol accents for @ strking look

300 x 250

Rec.pey

Ice Creom Cone Cupcake
Baking Rock

Nifty Home Products $15.95

r (22)
Mare Options » Beige & Gray Area Rug ’
Betievus GreenTool Area Rug by s of Hamplon 1
et lom More Options Available
$37.99 - $409.99 $1.0i653 $154.99 $432.00

Frea Shipping

Panel Bed by Simmons —
Casegoods
by Three Posts bibs 300 X 600

X R 08 from $254.98 $361:98 13750

7\’ 1
Storoge Solutions » Housekseping & Loundry » . R Holidoy Storoge » F

b %p d e \ Our Free
PYEN ' Free Shipping Aa | P Oniine
"%" 3 - (6) | & Mogee
AvATA

" e 90 ;

Emo Siver & Whka vory Arsa Groy Crcles Area g More Options Available

Rug by Zipcode Design

by Longiey Street 2 Dress the port with this ? Use this 3D poper pod to jot

$29.99 - $1,017.99 §52.50 $39.99 - $159.99 §5i.56 cuncake-themed aoron 8 down arocerv or to-do ksts

Page: 1 v NEXT 0

Advertisement

320x50

™ Get the Wayfair | o ..
iPhOne App » @ App Store




Email Integration

Our best-in-class email marketing reaches over 20MM
unique customers and prospects each week. Chances
are, your customers and prospects are some of them.

WHAT WE OFFER:

« Take advantage of our extensive email list to showcase
your brand and products

- Default targeting options: Geo, Device, Age, Gender,
Browser type, Day/Time, ISP

- Additional targeting options available at premium:
« Wayfair's 15t party data segments
- 3" party data through Nielsen, Towerd@ta, Netwise,
Webbula, Dataline, V12, or ALC

«  Other email integrations included with seasonal campaign
sponsorships, such as targeted emails to your most
relevant audience

Powered by

>

Buyers' Choice: Wall Decor
SHOP NOW)»

All That Jazz: Furniture Inspired by New
Orleans

SHOP NOW)

Gel It Together: Storage Solutions
SHOP NOW)

S00B¢250

_Epm ENDS 03/14
Ellen's Design Challenge: Around the World
SHOP NOW)»

&3
=

_05% [ 28 ENDS 02/12
Console Table Style Guide
SHOP NOW)»

N

Bedding from $40
SHOP NOW)

500250




@ C

If there is a brand integration worth exploring, we will

ustom Units

tailor it to your brand and build it.

:

. Q¥ CiP
wayfalr Find anything for your home... s e e

Furniture Décor Lighting Kitchen Bed & Bath Storoge Outdoor Home Improvement Baby & Kids Secsonal Gifts Sales

', < @
wayfalr | firomngtorou rome.. e
My Board Ideas  Account Cart

Furniture Décor Lighting Kitchen Bed & Both Storage Outdoor Home Improvement Baoby & Kids Seasonal Gifts Sales

Top Navigation Takeover Across All Woyfoir Pages

UP TO 70% OFF PRESIDENTS’ DAY BLOWOUT: =0 Lving Room » [3] Bedroom Furniture » LZa eodding »

Shop By Room
Bedroom

Living Room
Dining Room
Kitchen
Baothroom

Entry & Mudroom

B Homepage Takeover

Presidents’ Doy Sale

100% SOV

Woll Art
Drinkware
Bor Stools

Ways To Save

Daily Sales
Clecrance Outlet

Homepage Takeover

100% SOV

A~ o7 Bedroom Best Sellers — Daily Sales —

OFF = Score fumiture for the master suite, guest room & beyond »

UP TO 70% OFF PRESIDENTS' DAY BLOWOUT: = Living Room » [ Bedroom Furniture » LZa vedding »

hen > Bor&Wine > Wine Glosses > RedVondla > SKUt RVZ1047 Qfvwveyd

Viola Champagne Flute by Red Venilla
i dr ke ke 14 Reviews | Ask the First Question

$26.99 o™

Free Shipping on orders over $49.00
Ships by Tue (2/16)

Quantity: 1 (Set of 6)

Add to Cart < Save to Idea Board

Product Information:
Y

_5""""

Customers Also Viewed

Vineyord Reserve 8 .. Waytair Basics Cha.. Viola All Purpose Wi.. Viola 18.5 Oz Red ... Optic Champagne Fl... )
e ek e e Ak et dedeke Aok e e e e o
$23.99 $37.99 $3699 $39.99 $28.78
Information Shipping & Returns
Specifications
Weights & Dimensions
Cheor Finish

» Foture: 16" Hx 137" Wx 1375°D

s A 300 x 600

= Overall Product Weght: 5.9
« Conopy: 15" HX5"Wx 5 D
* Shode: 19" Hx 13.75"Wx 13.75° D

Seeded Finsh
o Foture: Smolt 16" Hx 16°H e 105" Wx 1378 W

+ More

Shipping & Returns

Ships to: I
o

What We Offer:

Attach your brand as the
“Recommended Care”
brand on Wayfair Product
Detail Pages

“Recommended Care” badge
Above the fold branding on
relevant product pages

Sponsored Product Care
Custom editorial block and
recommended care guide
created by Wayfair editors
with brand imagery, logos,
video, and/or creative
messaging

100% SOV of Page
300x250 and 300x600
units running next to
custom care content
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) Wayfair Segment
Targeting

No matter who you want to reach, you'll
already find them shopping at Wayfair.

Our visitors span a variety of life stages,
with unique personal styles and interests
— and they come to us because we cater
directly to the things that excite and

Inspire them.

5% S
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Free Shipping Over $49*

— fiii;?x

XY
wana}r Fied anylhing for your hame;; My Zrd: :»:i: A:@m 2%

Furniture Décor Lighting Kitchen Bed & Bath Storage Outdoor Home Improvement Baby & Kids Seasonal Gifts Sales

UP TO 70% OFF PRESIDENTS' DAY BLOWOUT: =] Living Room » x| Bedroom Furniture » :"9 Bedding »

NEW HOME mwsﬁ haves

The moving truck is unpacked; now save up to 70% on essentials to round out your space

1L

UP TO 70% OFF UP TO 70% OFF UP TO 70% OFF
Bedroom Furniture » Kitchen & Dining Furniture » Living Room Furniture »

~ii

Open for exclusive offers, w»’ﬁ;r'vm coupons, and more deals you'll love.

Brand Brand MEWEWM Brand Brand Brand

Save on everything home (and everything else!) with Wayfair and more shopper-favorite brands.

» -
B —— For business inquiries, contact postwiththemost@wayfair.com

13

Life Stage Marketing

We offer high-profile seasonal and evergreen
marketing partnerships, like our New Movers
program, that tap directly into this consistently
robust market.

« Work with our creative team to create fresh
and engaging content for new

homeowners, newlyweds, new parents, etc.

* Drive buzz around your brand by launching
a joint sweepstakes with Wayfair

*  Market exclusive offers with unique promo
codes

« Split the cost of direct mailers that reach
existing and potential shoppers most
relevant to your brand




7

Free Shipping Over $49* Help
* O ¥ ® @
Wanalr ind:gnything:for.your home: My Boards  Ideas  Account Cort

Furniture Décor Lighting Kitchen Bed & Bath Storage Outdoor Home Improvement Baby & Kids More... Gifts Sales

48 Sponsored Seasonal Campaign Integration

W5 hems wath thes woon amve by Chrissmas Hel

Trouble deciding on a desk? Shop styles that are perfect for your floor plan

*
WanalI‘.'com

. v > ® ©
wanalr Ny E;lrm |1;“r, 1&:‘11:' C.:

Fumniture  Decor  Lighting  Kitchen Bed & Bath  Storage  Outdoor  Home Improvement  Baby & Kids  Holidoys  Gifts  Sales

Find anything foe your home..

MY ACCOUNT Shop Daily Sales »

{17 Ove a Gt Carss I

iZ.DAILY SALES Up to 70% OFF. Limited-time deals start every day at 12 pm ET.

I
I Up to BON OFF Mofday Clearance » wiel Up to 70% OFF Deals at Your Coor by 12/34 »

Shop By Room
Bedroom

Living Room
Patio

Dining Room
Kitchen

Bathroom

Top Categories

Labor Day Sale

Lomps

Rugs

Wall Art .

s Happy Hosting Ui,
Discover Giada's secrets for a R

Ways To Save stress-free, stylish holiday season (® sunoars

Nna/10Cc
Daily Sales

Clearance Outlet

Blair Panel Storoge Bed Aspect Computer Desk 24 Pocket Over the Door. Brello Fioor Lamp
from $1,534.40 $2,258.00 from $25.08 $343.99
64 o 83 474 42

Scratch ‘'n Shopes Lorge.
$40.99

I

BMM@ Clearance

Save up to 65% on our coziest quilts and comforters »

— Daily Sales —

Up to 70% OFF »

A%

o
Eaniarar, S

CUSTOM HOMEPAGE HERO
Drives traffic to interstitial landing page

o

et

2 4y
-

STYLISH SAVINGS

) Giada’s Holiday Handbook

/ Comes to Life

Check bock each week to shop looks nspired by the latest episode

FROM GIADA'S KITCHEN
Happy Holidays,
Happy Cooking

Discover the latest cookbook
from Giada De Laurentiis »

HOLIDAY
HANDBOOK

Looks from Gicdo's Home » Open House »

Thanksgiving »

-

UP TO 70% OFF [RaiIsEgeie
Cabin Comforts: Bedding Sets & More
SHOP NOW >

(U R ZLLN ENDS 08/10

Furniture Showcase: Finds Under $400
™ SHOP NOW >

Happy Cooking
Bring home Gioda's latest
cookbook, hilled with nearly 200
Eisode 3 fresh now recpes. Episcde 4
Friendsgiving » Buy Now » Fomily Gathering »

SITE-WIDE NAVIGATION feature for
multiple days. FEATURED BLOCK on
interstitial linking to desired content

DAILY SALE EMAIL HEADER featuring

custom promotion



4y Sponsored Seasonal
Campaigns

At Wayfair, there's always something to
celebrate. Work with us to create highly
visible, high-impact seasonal campaigns
across print, web and our app.

« Reach 18M+ email subscribers through
variety of email integrations

* Drive mass awareness at scale with top-
navigation integration of your brand

 Integrate your products and brand into
Wayfair photography

* Tap into an engaged, purchase-ready
audience

D

SACK TO SCHOOL centhal,

Save on finds for kindergarteners, college kids, and every student in-between

)
©
29
=

Also Shop K-12 Sale »

Fumniture Décor Lighting Kitchen Bed &Bath Storage Outdoor Home Improvement Baby &Kids More... Gifts Sales

OOOOOOOOOO cenbral, - ]:
Up to 70% OFF All Sales »

UP TO 70% OFF

MERRY MARKDOWNS

A sleighful of festive furniture and décor savings to make spirits and settings shine

HOLIDAY DECORATIONS » FURNITURE & LINENS » ENTERTAINING ESSENTIALS »

HOLIDAY DECORATIONS

UP TO 70% OFF
Christmas Trees

> UP TO 70% OFF 5 UP TO 70% OFF >
Wreaths & Garlands Outdoor Décor

HOLIDAY o&oo)mfmq

Check out our editors’ best tips for
holiday decorating — from decking
the halls to trimming the tree »

5 UP TO 70% O >
Seasonal | Accents Festive Throw Pillows

UP TO 70% OFF FROM $3
Stockings & Tree Skirts > Ornaments & Trimmin gs >

10 70%
NS O

e el & kb

UP TO 70% OFF
Dorm Study Space »

D 70% OFF UP TO 70% OFF
N Bedding & Bath Basics » Dorm Rugs & Decor »

10 70%
O° ° Oy

a@om hoom




®
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Social Amplification

0000

Reach visitors across platforms with relevant
content on Facebook, YouTube, Instagram, and
Twitter that targets existing Wayfair customers
who are actively engaged with our brand.

WHAT WE OFFER:

« Shared campaigns that strengthen brand

association and awareness

 Custom creative tailored to social media
iIndustry standards

« Co-branded, targeted posts that drive traffic
to sponsored content on Wayfair.com

You Q Upload Q q

Wayfair.com 3 Subscribe [EEN

Home Videos Playlists Channels Discussion m

A

MODERN

" CRAZY-COOL
BAR STOOL

4

! _r;: h %

Easy DIY: How to Hang a Gallery  Easy Tips for Tying Together a
Wall with HGTV's Peyton... Home with HGTV's Peyton...

DIY 1 Bar Stool 3 Ways with Krylon™

- 3
BLOCKED D{Sf(’( Coastat
BAR STOO

by Wayfair.com by Wayfair.com
25,676 views - 6 days ago 32,205 views * 1 week ago wayfair‘com
D) Subscribe [0
_ , | 3 subscribe | 126,310
Discover Wayfair
L

= Addto @ Share  ees More

Welcome to Wayfair.com's Home Furniture, Decor & More | Learn More About Wayfair.com!

TR




wayfa?r.aom n

HGTV

TV Integration

Increase brand awareness with co-branded
Integration opportunities into relevant networks
and programs.

INTEGRATION OPPORTUNITIES FOR 2016:

+ Q3 Beachfront Bargain Hunt Reno
(Wayfair/HGTV)July 14 — Sept 22 every other
(6 weeks)

* Q3 Flip or Flop Beach Special
(Wayfair/HGTV)Aug 1 — 22 (4 weeks)

* Q3 Listed Sisters (Joss & Main/HGTV) Sept 13
— Oct 18 (6 weeks)

* Q4 Giada (Wayfair/Food Network)TBD



(5) Our Network of
Influencers

wayfa?r 1 GNAg Y pir Porre

Forae Odote Lgrang Onowes Bad B Drh  Somage  Oiudr Mo e v e Sty & s

VS0 PO OFF AL AL .‘ Vs & WA » W WAy ey

Gt wapred oton Bapvg Onndes Mop e Woca

Strategically amplify the value of your brand

it At aatendde TRalerama, At S P T

Jana Bok: Master Bath Makeover Rovoal

by leveraging Wayfair’'s VIP network of
bloggers, designers, and experts.

OUR SCOPE BY THE NUMBERS:

* 300+ curated bloggers

* Pre-screened influencers with strong ties to

—"““""‘"‘*““"'”‘“"“‘"""’""" o .. /IS N 11 / their readers and significant followings

« Total reach of 112M+ uniques

- Average reach of an influencer is 260K+

- Average social reach is 200K+

BBEK DESICGN| + KOHLER
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@ Trade Services
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Influencers

Grow your brand with content placements
and Trade-exclusive promotional campaigns
catered to design professionals.

Gain exclusive access to our community of
top industry influencers, including interior
designers, architects, and home stagers.

OPPORTUNITIES INCLUDE:

* Sponsor a Trade Services event (Annual
Tastemaker Awards, High Point Market, many
more) to get valuable exposure to prominent

names in the home design industry

* Target users who are actively logged into @

Trade account

* Build a custom brand page tailored to Trade

audience

trade
SERVICES

Shop our brangs. Wayfalr |

My Account Manager
Richard St Germain
617-502-7709

AliModern | Birch Lane | DwellStudio

Summer Shades

The right shade can transform your room. Bright, bold, and perfect for summer, these
Sherwin-Williams shades are about to give your space a sunny makeover,

wayfa?r.com 6 SHERWIN-WILLIAMS.

Reflecting Pool

Singing the blues has never looked so good.
At first glance, this bold teal hue would be
perfect for a fun accent wall, but paired with
soft yellow furniture and juicy lime green
accents, it's the ultimate coastal shade.

SHOP NOW »

Coral Reef

Whether you're on the shores of Bermuda or
In the ‘burbs, this punchy coral hue will
transport you to a tropical place. Or, opt to go
Paim Beach glam with metallic accents that
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Sister Brands

Join our extended family! We offer even more opportunities for exposure through our bold lifestyle brands.
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